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1A Diffusion through Membranes 1           

1B Osmosis  1          

 

2 
Enzyme Action (Method 1)   1         

Enzyme Action (Method 2)  1          

3 Mitosis and Meiosis No sensor 

4A Plant Pigment Chromatography No sensor 

4B Photosynthesis    1        

 

 
5 

Cell Respiration (Method 1)   1  1       

Cell Respiration (Method 2)     1       

Cell Respiration (Method 3)   1         

Cell Respiration (Method 4)  2          

6A pGLOTM Bacterial Transformation No sensor 

 

6B 
Analysis of Precut Lambda DNA (Option 1)          1 1* 

Forensic DNA Fingerprinting (Option 2)          1 1* 

7 Genetics of Drosophila No sensor 

8 Population Genetics and Evolution No sensor 

9 Transpiration  1         O 

10A Blood Pressure as a Vital Sign      1      

10B Heart Rate and Physical Fitness       1     

11 Animal Behavior No sensor 

12A Dissolved Oxygen in Water        1 1   

12B Primary Productivity        1    

13 The Visible Spectra of Plant Pigments    1+        

14 Determination of Chlorophyll in Olive Oil    1+        

15 Enzyme Analysis using Tyrosinase    1        

16 Introduction to Neurotransmitters using ACHe    1        

17 Macromolecules: Experiments with Protein    1        

 

* - Included in the Blue or White Digital Bioimaging System 

O - Optional 

+ - Spectrometer only 
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Transpiration 

Water is transported in plants, from the roots to the leaves, following a decreasing water 
potential gradient. Transpiration, or loss of water from the leaves, helps to create a lower 
osmotic potential in the leaf. The resulting transpirational pull is responsible for the movement of 
water from the xylem to the mesophyll cells into the air spaces in the leaves. The rate of 
evaporation of water from the air spaces of the leaf to the outside air depends on the water 
potential gradient between the leaf and the outside air.  

Various environmental factors, including those conditions which directly influence the opening 
and closing of the stomata, will affect a plant’s transpiration rate. This experiment will measure 
transpiration rates under different conditions of light, humidity, temperature, and air movement. 
The data will be collected by measuring pressure changes as the plant takes up water into the 
stem. 

 
OBJECTIVES 

In this experiment, you will 

• Observe how transpiration relates to the overall process of water transport in plants. 

• Use a handheld interface and a Gas Pressure Sensor to measure the rate of transpiration. 

• Determine the effect of light intensity, humidity, wind, and temperature on the rate of 
transpiration of a plant cutting. 

 

 

Figure 1 
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MATERIALS 

LabQuest metric ruler 
LabQuest App masking tape 
Vernier Gas Pressure Sensor plastic gallon size bag with twist tie 
utility clamps heater, small electric 
ring stand fan with slow speed 
plant cuttings aerosol spray container or plant mister 
plastic tubing clamps plastic syringe 
dropper or Beral pipette graph paper or Logger Pro program 
razor blade or scalpel ProScope (optional) 
100 watt light source  

 
 
PROCEDURE 

 
1. Position the ring stand, utility clamps, and Gas Pressure Sensor as 

shown in Figure 1. 

2. Prepare the plastic tubing. 

a. Connect the plastic syringe to one end of a 36–42 cm piece of 
plastic tubing. 

b. Place the other end of the tubing into water and use the syringe to 
draw water up into the tubing until it is full. Tap the tubing to expel 
any air bubbles that form inside the tube. 

c. Slip a plastic tubing clamp onto the tubing as shown in Figure 2.  

d. Bend the tubing into a U shape with both ends up. Remove the 
syringe, leaving the tubing full of water.  

 
3. Select a plant which has a stem roughly the same diameter as the opening of the plastic 

tubing. Using a scalpel or razor blade, carefully cut the plant one inch above the soil. Place 
the plant under water against a hard surface and make a new cut at a 45° angle near the base 
of the stem. 

4. Connect the plant to the tubing. 

a. The plastic tubing has a white plastic connector at one 
end that allows you to connect it to the valve on the Gas 
Pressure Sensor. Raise the end of the tubing with the 
connector until you see water beginning to drip out of the 
other end.  

b. Carefully push the cut stem of the plant down into the 
end of the tubing where the water is dripping out. Be 
careful not to allow any air bubbles to form between the 
cut portion of the stem and the water in the tube.  

c. Push the plant down as far as it will go without damaging 
the plant. At least one centimeter of the plant stem should 
fit into the tubing. If the stem is too large for the tubing, 
cut the stem at a higher point where it is smaller.  

d. Squeeze the tubing clamp shut as tight as possible as shown in Figure 3. 
 

Figure 2 

Figure 3 
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5. When the tubing clamp is shut tight, invert your plant cutting to check for any leaks. If water 
does leak out, turn the plant right-side up and try tightening the clamp further. 

 Important: Be sure the tubing is filled completely with water. The water column must be 
flush with the stem. There should be no air visible at the base of the stem. If water moves 
down the tube away from the stem after it has been inserted, check for a leak in the system. 

6. Connect the plastic tubing to the sensor valve. Caution: Do not allow water to enter the 
valve of the Gas Pressure Sensor. 

7. Secure the plant in an upright position with the utility clamps as shown in Figure 1. It should 
be positioned so that the cut stem is about 8 cm below the water level at the other end of the 
tubing, as shown in Figure 1. 

8. Place a mark on the tube at the starting water level to allow you to refill the tube to the proper 
level when you repeat data collection. 

9. Place your plant setup in an area where the wind, humidity, and temperature are reasonably 
constant. This will be your control setup.  

 10. Allow the system 5 minutes to adjust to the environment. Proceed to the next step to set up 
the sensor and LabQuest while the system is adjusting. 

 11. Connect the Gas Pressure Sensor to LabQuest and choose New from the File menu. If you 
have an older sensor that does not auto-ID, manually set up the sensor. 

 12. On the Meter screen, tap Length. Change the data-collection length to 900 seconds. Select 
OK. 

 13. Check the base of the plant stem in the water tube to make sure that no air bubbles or air 
pockets have formed that will prevent the plant from taking up water. If an air pocket has 
formed, refit the plant in the tubing before initiating data collection in Step 13. 

 14. After the plant has equilibrated for 5 minutes, start data collection. Data will be collected for 
15 minutes and then a graph of pressure vs. time will be displayed. If it is necessary to quit 
data collection early, you can stop data collection to view a graph of pressure vs. time. 

 15. When data collection has stopped, perform a linear regression to calculate the rate of 
transpiration. 

a. Choose Curve Fit from the Analyze menu. 

b. Select Linear as the Fit Equation. The linear-regression statistics for these two data 
columns are displayed for the equation in the form 

y = mx + b 

where x is time, y is pressure, m is the slope, and b is the y-intercept.  
c. Enter the absolute value of the slope, m, as the rate of transpiration in Table 1. 

d. Select OK. 
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 16. Design an experiment to simulate one of the following environmental conditions, as assigned 
by your teacher: 

• the effect of light intensity 

• the effect of the wind blowing on the plant 

• the effect of humidity 

• the effect of temperature 

• the effect of another self-identified environmental variable 
 
 Be sure to address the following questions in your design:  

• What is the essential question being addressed? 

• What assumptions are made about the system being measured? 

• Can those assumptions be easily verified? 

• Will the measurements provide the necessary data to answer the question under study?  
 

 17. After checking your procedure with your teacher, obtain the materials needed for the 
experiment and perform the tests. Record your values in Table 1. 

 
PROCESSING THE DATA 

1. Determine the surface area of all the leaves on your plant cutting by using one of the 
following methods: 

 Method 1 – Using Logger Pro to Determine Leaf Surface Area 

 This method requires a ruler, a digital camera such as a ProScope HR with the 1–10X lens, 
and Logger Pro software. 

a. Carefully remove the leaves from the 
stem.  

b. Select a sample leaf and place it on a flat 
surface with a ruler along the horizontal 
axis of the leaf to provide scale. Place a 
clear Plexiglas plate over the leaf 
specimen (optional). 

c. Select Video Capture from the Insert 
menu. Adjust the ProScope HR lens 
making sure that both the leaf and the ruler 
are in focus. The ProScope handle should 
be parallel to the table surface to avoid 
angular distortion. 

d. Click  to capture the leaf image. 
Note: The captured image may be hidden 
behind the Video Capture window. Close 
the Video Capture window. 

e. Select Auto Arrange from the Page menu. Note: If there are no analysis buttons along the 
right side of the captured image as seen in Figure 4, double-click on the image. Select 
Standard Analysis from the Picture Analysis options and select OK. 

Figure 4 
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f. Set the scale of the image by clicking Set 
Scale, . Click and drag the cursor 
between two distinct points on the ruler 
separated by several centimeters. Enter 
the distance between the points and the 
units. Select OK. 

g. Click Add Point, . Move your cursor 
to the edge of the leaf and click to add a 
point. Circumscribing the leaf with points 
in a sequential clockwise manner as 
shown in Figure 5. Points need to be 
close enough to register all directional 
changes along the leaf edge. Place the 
final point directly on top of the starting 
point.  

h. Click the Integral button, . The displayed integral value is equal to the surface area of 
the leaf. Record this value in the Individual Leaf Surface Areas table below.  

i. Repeat Steps 1a–h for each leaf. 

j. Add the surface areas of all the leaves and record the total surface area in Table 1.  
 

Individual Leaf Surface Areas  

Leaf 
Number 

Surface Area 

(cm2) 

Leaf 
Number 

Surface Area 

(cm2) 

Leaf 
Number 

Surface Area 

(cm2) 

Leaf 
Number 

Surface Area 

(cm2) 

        

        

 

 Method 2 – Using Mass to Determine Leaf Surface Area   

 This method requires a balance. 

a. Cut all the leaves (not stems) off your plant and determine their mass using a balance. 

b. Estimate the total leaf surface area in cm2 for your plant by cutting out a section of leaf 
5 cm  5 cm. 

c. Determine the mass for this leaf section and divide by 25 cm2 to find the mass of l cm2 of 
leaf. 

d. Divide the total mass of the leaves by the mass of l cm2 to find the total leaf surface area. 

e. Record the calculated surface area in Table 1. 
 
2. Calculate the rate of transpiration/surface area. To do this, divide the rate of transpiration by 

the surface area for each plant. These rate values can be expressed as kPa/min/cm2. Record 
the rate/area in Table 1. 

3. Subtract the control (rate/area) value from the experimental value. Record this adjusted rate 
in the last column of Table 1. 

4. Record the adjusted rate for your experimental test on the board to share with the class. 
Record the class results in Table 2 for each of the environmental conditions tested. If a 
condition was tested by more than one group, take the average of the values and record in 
Table 2. 

Figure 5 
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5. Make a bar graph that shows the effect of different environmental conditions on the 
transpiration of water in plant cuttings. Using the data in Table 2, plot the adjusted rate for 
each test on the y-axis and the test label on the x-axis. 

 
DATA 

Table 1 

Test 
Slope 

(kPa/s) 
Surface area 

(cm2) 
Rate/area 

(kPa/s/cm2) 
Adjusted rate 
(kPa/s/cm2) 

Experimental
________

     

Control     

 

 

Table 2: Class Data 

Test 
Adjusted rate 
(kPa/s/cm2) 

Light  

Humidity  

Wind  

Temperature  

 
 
QUESTIONS 

1. How was the rate of transpiration affected in each of the experimental situations as compared 
to the control? 

2. Which variable resulted in the greatest rate of water loss? Explain why this factor might 
increase water loss when compared to the others. 

3. What adaptations enable plants to increase or decrease water loss? How might each affect 
transpiration? 
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EXTENSIONS 

1. Using a compound microscope, identify the vascular tissues of a plant stem. Describe the 
function of each tissue type identified.   

a. Obtain a section of stem from the plant you used during the transpiration experiment. 

b. Using a nut-and-bolt microtome, carefully cut 6 cross sections of the plant stem. The cross 
sections should be cut as thin as possible. 

c. Place each of the cross sections in a dish or cup of 50% ethanol solution for 5 minutes. 

d. Remove the cross sections from the alcohol and place them in a dish containing toludine 
blue O stain for 5 minutes. 

e. Rinse the cross sections with distilled water and mount them on a microscope slide with a 
drop of 50% glycerin. Place a cover slip on the slide and examine the cross sections using 
a compound microscope. 

f. On a separate sheet of paper, make a drawing of the cross sections. Identify and label the 
cell and tissue types described by your teacher. 

 
2. Test cuttings from a variety of different plant species. How does each compare? 

3. Count the number of stoma/cm2 for each of the plants in Extension 1. How does this relate to 
the plant’s ability to transpire water? 

4. Design an experiment to test for the variables in Question 3. 
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Determination of  
Chlorophyll in Olive Oil 

Olive oil is made by pressing or extracting the rich oil from the olive fruit. It seems like a simple 
matter to press the olives and collect the oil, but many oil extraction processes exist for the many 
different types of olives grown around the world. To complicate things further, there are also 
various grades of olive oil, and carefully selected groups of officials meet to define and redefine 
the grading of olive oil. To help make our experiment a more scientific and less political 
exercise, we will winnow our investigation of olive oil down to a manageable few variables. 

After processing, olive oil comes in three common grades: extra virgin, regular, and light. Extra 
virgin olive oil is considered the highest quality. It is the first pressing from freshly prepared 
olives. It has a greenish-yellow tint and a distinctively fruity aroma because of the high levels of 
volatile materials extracted from the fruit. Regular olive oil is collected with the help of a warm 
water slurry to increase yield, squeezing every last drop of oil out of the olives. It is pale yellow 
in color, with a slight aroma, because it contains fewer volatile compounds. Light olive oil is 
very light in color and has virtually no aroma because it has been processed under pressure. This 
removes most of the chlorophyll and volatile compounds. Light olive oil is commonly used for 
frying because it does not affect the taste of fried foods, and it is relatively inexpensive. 

The visible light absorbance spectrum of chlorophyll gives interesting results. The chemistry of 
chlorophyll (some references site four types: a, b, c, and d) creates absorbance peaks in the  
400–500 nm range and in the 600–700 nm range. The combination of visible light that is not 
absorbed appears green to the human eye, but different sources of chlorophylls will have 
different ratios of these peaks, which create various shades of green. The ability of chlorophyll to 
soak up light energy across a wide swath of the visible range helps power photosynthesis at 
optimum efficiency in plants. 

In this experiment, you will have two primary goals. First, you will analyze the various grades of 
olive oil to determine the absorbance peaks that are present and the relative amount of 
chlorophyll found in each grade. You will use a Spectrometer to measure the absorbance of the 
olive oil samples over the visible light spectrum. You will then test an unknown sample of olive 
oil and grade it as extra virgin, regular, or light. 

 
OBJECTIVES 

In this experiment, you will 

• Measure and analyze the visible light absorbance spectra of three standard olive oils: extra 
virgin, regular, and light. 

• Measure the absorbance spectrum of an “unknown” olive oil sample. 

• Identify the unknown olive oil as one of the three standard types. 
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MATERIALS 

LabQuest olive oil of unknown grade 
LabQuest App five cuvettes and lids 
Spectrometer plastic Beral pipets 
samples of three olive oil standards: distilled water 
    extra virgin, regular and light isopropyl alcohol 

 
 
PROCEDURE 

1. Obtain and wear goggles. 

2. Connect the Spectrometer to LabQuest and choose New from the File menu. 

3. Obtain small volumes of the three standard and one unknown olive oils. Transfer enough of 
one olive oil sample to fill a cuvette 3/4 full. Place a lid on the cuvette and mark the lid. 
Prepare all of your samples in this way so that you have four cuvettes of olive oil with 
labeled lids. 

Part I  Comparing Three Grades Of Olive Oil and Identifying an Unknown 

For Part I of this experiment, you will calibrate the Spectrometer with distilled water. Your goals 
are: (1) to compare the absorbance spectra of the different grades of olive oil; and (2) to identify 
the grade of an unknown sample of olive oil. 

4. Calibrate the Spectrometer. 

a. Prepare a blank by filling an empty cuvette 3/4 full with distilled water. 

b. Choose Calibrate from the Sensors menu.  

c. When the warmup period is complete, place the blank in the Spectrometer. Make sure to 
align the cuvette so that the clear sides are facing the light source of the Spectrometer.  

d. Tap Finish Calibration, and then select OK. 
 
5. Conduct a full spectrum analysis of an olive oil sample. 

a. Place one of the olive oil samples in the Spectrometer. 

b. Start data collection. A full spectrum graph of the olive oil will be displayed.  

c. Stop data collection. 

d. Review the graph to identify the peak absorbance values. 
 
6. Tap the File Cabinet icon to store your data. 

7. Repeat Steps 5–6 with the remaining olive oil standard samples. 

8. Repeat Step 5 with the unknown. Note: Do not store the last run. 

9. Examine the plots of the olive oil samples. Before continuing with data collection, answer the 
Part I Data Analysis questions. Sketch, print, or save your experiment file, as instructed. 

 10. Rinse and clean the cuvettes and other oil-bearing containers with isopropyl alcohol.  
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Part II  Comparing the Chlorophyll Concentration of Regular and Extra Virgin Olive Oil  

In Part II, you will use the light grade of olive oil to calibrate the Spectrometer and presume that 
light olive oil contains no chlorophyll. Next, you will compare the chlorophyll content of the 
regular grade with the extra virgin grade. 

 11. Set up a new file and calibrate the Spectrometer using light olive oil. 

a. Choose New from the File menu. 

b. Prepare a blank by filling an empty cuvette 3/4 full with light olive oil. 

c. Choose Calibrate from the Sensors menu. 

d. When the warmup period is complete, place the light olive oil blank in the Spectrometer. 
Make sure to align the cuvette so that the clear sides are facing the light source of the 
Spectrometer 

e. Tap Finish Calibration, and then select OK. 
 

 12. Measure the absorbance spectrum of regular and extra virgin olive oil. 

a. Remove the cuvette of light olive oil from the Spectrometer and replace it with the cuvette 
of regular olive oil. 

b. Start data collection. A full spectrum graph of the regular olive oil will be displayed. Note 
the slight difference in the plot as a result of using the light olive oil as the calibration 
blank.  

c. Stop data collection. 

d. Tap the File Cabinet icon to store your data 

e. Repeat data collection to measure the absorbance spectrum of the extra virgin grade.  
 

 13. Sketch, print, or save your data, if instructed to do so. 

 
DATA ANALYSIS 

Part I  Comparing Three Grades Of Olive Oil and Identifying an Unknown 

1. Describe the graph of each of the standard olive oil 
solutions. Emphasize the differences between each 
grade of olive oil, identifying the absorbance peaks 
and other distinguishing features. 

2. Compare the absorbance spectra of the three grades of 
olive oil with the sample in Figure 1. What evidence is 
there that regular and extra virgin olive oil contain 
chlorophyll while the light grade of olive oil does not? 

3. Identify your unknown olive oil as extra virgin, 
regular, or light. Explain your choice. 

Part II  Comparing the Chlorophyll Concentration of Regular and Extra Virgin Olive Oil  

4. Which grade of olive oil, regular or extra virgin, contains the greater amount of chlorophyll? 
Use your absorbance spectrum graphs to speculate about how much more chlorophyll one 
grade contains compared to the other. 

Figure 1 
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EXTENSIONS 

1. Chlorophyll is a fluorescent molecule. Fluorescent molecules can absorb light of one 
wavelength and then reemit light at a new and longer wavelength of light. As you have seen 
in this exercise, chlorophyll absorbs light in the violet and blue regions of the spectra. If you 
were to shine a violet or blue light through a sample of extra virgin olive oil, you would see 
the oil turn red in color. The intensity of the red color is an indication of how much 
chlorophyll is in the olive oil. The “Long-Wave UV Pen Light” from Bio-Rad Laboratories, 
Inc. (Catalog # 166-0530EDU) can be used for this purpose. Shine the light from the 
Long-Wave UV Pen Light through a cuvette containing extra virgin olive oil. Does the 
sample that is hit by the light turn red in color? Repeat this test for regular olive oil, light 
olive oil, and your unknown. Could you use this method to determine if a sample of olive oil 
is really extra virgin olive oil? Could you use this method to determine the grade of any 
sample of olive oil? 

2. Fluorescence spectroscopy is another method that can be used to determine the quality of 
olive oil. In fluorescence spectroscopy, a sample can be “excited” with a chosen wavelength 
of light and the resulting fluorescence from the sample can be measured and quantified. The 
SpectroVis Plus from Vernier Software & Technology can be used for this purpose. Follow 
the directions below to measure the fluorescence of all of your olive oil samples using the 
SpectroVis Plus.  

a. Connect the Spectrometer to LabQuest. Choose New from the File menu. 

b. Place the cuvette containing the extra virgin olive oil into the cuvette slot of the 
Spectrometer.  

a. Choose Change Units ► Fluorescence 405 nm from the Sensors menu.  

c. Tap Mode. Change the data-collection length to 150 ms. Select OK.  

d. Start data collection. A full spectrum graph of the fluorescence of the oil will be 
displayed. Note that one area of the graph contains a peak at approximately 675 nm. This 
peak is from chlorophyll. Stop data collection. 

e. If necessary, adjust the sample time to increase or decrease the size of the fluorescent 
peak. If the peak intensity is above 1, decrease the sample time by 10 ms and collect a 
new fluorescent spectrum. Continue to decrease the sample time until the peak is fully 
visible. If the fluorescent peak is below 0.3, increase the sample time by 10 ms and collect 
a new fluorescent spectrum. Continue to increase the sample time until the peak 
fluorescent amplitude for the chlorophyll is above 0.8.  

f. Once you have a nice peak, store your data by taping the File Cabinet icon. 

g. Collect full spectrum graphs from the remaining olive oil samples. Store each run. Do not 
adjust the sample time. 

h. Compare the fluorescent spectra of the three grades of olive oil. The peak that is visible at 
approximately 675 nm is from chlorophyll. Which sample has the largest peak in this 
region?  

i. Using the fluorescence from the known olive oil samples as your standards, determine the 
quality of your unknown olive oil sample. 

j. Compare your results using fluorescent spectroscopy to your results using traditional 
spectroscopy. Is one method better than the other? If so, please explain why. 

k. Print or save your experiment file as directed. 

 


